
XNet Monitor
Version 1.6.8 | May 2022

USER MANUAL





Disclaimer
This manual and the information contained herein are the sole property of EVS Broadcast Equipment SA
and/or its affiliates (EVS) and are provided “as is” without any expressed or implied warranties, including,
but not limited to, the implied warranties of merchantability and fitness for a particular purpose. In
particular, EVS makes no warranty regarding the use or the consequences of use of this manual and the
information contained herein. Furthermore, EVS may not be held liable for any direct or indirect,
incidental, punitive or consequential loss, damage, cost or expense of any kind whatsoever and
howsoever resulting from the normal or abnormal use of this manual and the information contained
herein, even if advised of the possibility of such loss, damage, cost or expense.

While every effort has been made to ensure that the information contained in this manual is accurate,
up-to-date and reliable, EVS cannot be held liable for inaccuracies or errors that may appear in this
publication. The information in this manual is furnished for informational purpose and use only and
subject to change without notice.

This manual cancels and replaces any previous versions thereof.

Copyright
Copyright © 2009-2022 EVS Broadcast Equipment SA. All rights reserved.

This manual may not be reproduced, transcribed, stored (in a database or a retrieval system), translated
into any language, computer language, transmitted in any form or by any means – electronically,
mechanically, printed, photocopied, optically, manually or otherwise – in whole or in part without the
prior written consent of EVS.

Trademarks
All product and brand names are registered trademarks and trademarks of EVS or of their respective
owners.

Improvement Requests
Your comments will help us improve the quality of the user documentation. Please send improvement
requests, or report any error or inaccuracy on this user manual by e-mail to doc@evs.com.

Regional Contacts
You will find the full list of addresses and phone numbers on the following webpage:
http://www.evs.com/contact.

User Manuals on EVSWebsite
The latest version of the user manual, if any, and other user manuals on EVS products can be found at
the EVS download center, on the following webpage: https://www.evs.com/en/download-area.
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What's New?
In the User Manual the icon  has been added next to the text to highlight information on new
and updated features.

The changes linked to new features in version 1.6.8 are listed below.

RAID Type 10+2 is supported.

• See section "Storage Tab" on page 24.

An Interface column can be added to the Monitoring List.

A second PC LAN column is displayed in Dual PC LAN mode.

• See section "Network Connection Settings Area" on page 22.

QSFP interfaces are displayed in the IP Interface Monitoring table in case the server is connected with
the XHub-VIA Live IP Aggregator.

• See section "Live IP Tab" on page 31.
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1. Introduction

1.1. Product Overview
XNet Monitor is a tool aimed at monitoring EVS products. It displays real time information and status
about the EVS video servers and other EVS products, as well as past alert and warning messages.

XNet Monitor uses the SNMP (Simple Network Management Protocol) protocol to request and receive
monitoring data from the EVS servers. This internal status data is defined in the MIB (Management
Information Base) on each EVS server.

One XNet Monitor application can monitor several EVS servers and other EVS products while one EVS
server or product may also be monitored by several XNet Monitor applications.

XNet Monitor is mainly a monitoring application that cannot act on the monitored servers. Some remote
actions are however possible: Multicam version upgrade, keyword file maintenance, as well as remote
access to an EVS server desktop, or to an LSM Remote Panel.

The full list of EVS products that can be monitored with XNet Monitor are specified in the
release notes. All currently supported EVS servers can be monitored with XNet Monitor.

1.2. Installation

Requirements

• PC compatible computer

• Supported OS: Windows Server 2008 R2, Windows 7, Windows 10

• .Net framework 4.6 or higher installed

Recommendation

The SNMP information is available through the PC LAN connector of the server. The computer running
XNet Monitor should be connected to the same network, and not on any of the Gigabit Ethernet ports of
the servers. These ports are dedicated to high flow video data and cannot be used for any other
purpose.

Upgrade and Downgrade

If an older version of XNet Monitor is already installed on your computer, it will be automatically removed
and replaced by the new one when you will install the new version of XNet Monitor.
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The XNet Monitor application must only be removed if you need to downgrade the application.
Removing the application can be done as usual, through Windows Control Panel and Add or Remove
Programs menu.

1.3. Accessing the Application
How to Open XNet Monitor

To open the XNet Monitor application, do one of the following actions:

• Click the XNet Monitor icon on the desktop

• Click the Windows icon and select EVS Broadcast Equipment > XNet Monitor.

1.4. User Interface Overview

Introduction

When you access XNet Monitor, the main window is displayed. The schema below highlights the various
areas on the main window.
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Area Description

The table below describes the various parts of the XNet Monitor main window:

# Window area Description

1. Menu bar It gives access to various functions.

See section "Menu Bar" on page 4.

2. Monitored Device
tree

It displays the monitored devices in a user-defined tree architecture.

See section "Description of the Monitored Device Tree" on page 6.

3. Monitoring Data area It displays diferent data depending on what is selected in the Monitored
Device Tree:

• Detailed information on the selected EVS server.

The area is then called the Server Details area.

See section "Overview on the Server Details Area" on page 17

• Detailed information when another EVS hardware is selected.

The area is then called the Device Details area.

See section "Device Details" on page 33.

• Summary information on several devices when a group of devices is
selected.

The area is then called the Monitoring List area.

See section "Description of the Monitoring List" on page 15

4. Alert Information
area

It allows users to display and acknowledge the alerts.

See section "Managing Alerts" on page 38

5. Disk Usage It displays a pie chart with the total used and remaining disk space for the
selected device.

6. Status bar It provides information about the monitoring status.
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1.5. Menu Bar

General Description

The menu bar gives access to various functions. You will find below a short description of the menu
items.

Area Description

The following table presents the items on the menu bar:

Menu Description

File menu Allows you to manage the EVS servers and other EVS devices stored in the
Monitor Device tree.

See section "Managing the Monitored Device Tree" on page 11

Tools menu Gives access to the configuration tools and settings described in these
sections:

• "Customizing the Monitoring List" on page 9

• "Organizing Monitored Devices" on page 7

• "SNMP and General Settings" on page 12

• "Trap Configuration" on page 10

Gives access to commands to manage Multicam versions and keyword files on
the EVS servers:

• "Multicam Upgrades" on page 53

• "Uploading a Keyword File on an EVS Server" on page 59

Monitoring menu Allows you to start or stop the monitoring on the EVS servers and devices
displayed in the Monitored Device Tree.

See section "Start Monitoring" on page 14

Help menu Gives access to the user manual and information about the application.
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2. Configuration

2.1. Network Settings

Introduction

Should you face issues to set up XNet Monitor in your network, and should a network configuration be
required, you will find the necessary network information in this section.

Description

Monitoring

• Monitoring protocol :SNMP

• Communication for the polling : TCP on port 161 (bidirectional)

• Communication of the SNMP traps : UDP on port 162 (outbound out of the server only)

Remote desktop and LSM Remote functions

• TCP 50000 (bidirectional)

Config Web

• Communication in HTTP on port 80 (bidirectional)
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2.2. Monitoring Configuration

2.2.1. Description of the Monitored Device Tree

Introduction

The Monitoring Devices Tree displays the devices monitored on the network. They are listed in a tree
architecture independent of the network architecture as shown on the screenshot below. The
Monitoring list is defined by the user.

XNet Node

The higher node is called XNet as it represents the EVS XNet proprietary network. Under this first level
node, you must add one or more groups. These groups are only virtual groups used for easy organization
and management of multiple servers.

Groups

The groups are defined by the user. The group definition is not tied to the network architecture: this is
only a virtual layout the user can organize freely. For easier management, it is recommended to organize
the groups based on physical localization of the devices.

Hosts

The hosts are the monitored devices themselves. You can create themmanually or automatically as
explained in See section "Organizing Monitored Devices" on page 7.

Status Summary

In the Monitored Device Tree, a colored bullet displayed next to the group or device provides a summary
of the device status, and has the following meaning:

• A red bullet means that there is a warning and/or an error on a host.

• A green bullet means that everything is ok for that item.

The number between brackets next to an item indicates the number of pending SNMP alert messages.
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2.2.2.Organizing Monitored Devices

Introduction

To organize the monitored devices in the Monitoring List, you first have to create groups under the XNet
node. Then, you can add the monitored devices under the created groups, either manually or
automatically.

How to Add and Remove Groups

For an easy management, it is recommended to organize the groups based on physical localization of
servers.

To add a new group, proceed as follows:

1. Right-click on the XNet node and select Add group.

2. Enter a representative group name.

To remove a group, right-click on it and select Remove.

How to Add Devices Manually

To add individual devices manually, proceed as follows:

1. Right-click on a group and select Add host.

2. Enter the device IP address in the Host Definition window.

You can also enter the hostname if it has been declared in a DNS server or in a host file.

Once the devices are entered in the list manually, you can organize them in the different groups by drag-
and–drop operation.
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How to Add Devices Automatically

1. Open the Tools menu and select Discover.

The Discover SNMP Agents window opens

2. In this window, set the IP address range in which the program will look for available devices.

3. Click the Start button to start the discovery process.

At the end of this process, the discovered devices will be listed in a new group called Discovered Hosts.

Once the devices are entered through the discovery process, you can organize them in the different
groups by drag-and–drop operation.

As this process is based on timeout for not used addresses, it may take some time to
parse a long list.

How to Remove a Device

You can only remove a device when the monitoring is not started.

To remove a host, right-click on it and select the Remove command.
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2.2.3.Customizing the Monitoring List

Introduction

When you select XNet or a group in the Monitored Device Tree, the Monitoring Data pane displays the
Monitoring List, which provides summary data about the servers available under XNet or under the
selected group.

You can specify which information should be displayed in the Monitoring List and how it should be
displayed via the Select Columns window.

How to Customize the Data

To customize the summary monitoring data, proceed as follows:

1. In the Monitoring Data pane, select the Organize Columns command from the Tools menu.

2. The Select Columns window opens:

3. Do one of the following actions:

◦ To add a column to the display, select it in the left Available columns list and click on the Insert
button.

◦ To remove a column from the display, select it in the right Selected Columns list and click on the
Remove button.

◦ To change the columns order, select a column name in the right Selected Columns list and move
it up or down in the list using the Up and Down buttons respectively.

4. Click on OK once the columns are organized as desired.
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2.3. Trap Configuration

2.3.1. Description of the Trap Configuration
Window

Overview

You can access Trap Configuration window by selecting the Tools menu, and the Trap Configuration
command.

The Trap Configuration window displays the host tree (EVS servers or other EVS hardware). For each
host, the list of IP addresses of the computers registered to the host to receive its SNMP trap messages.
Such a computer is called a trap target.

The trap targets can be computers that host the XNet Monitor application or a polling service of XNet
Monitor.

The Trap Configuration window contains the areas or buttons highlighted on the screenshot below:
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Area Description

The table below describes the various parts of the Trap Configuration window:

Part Name Description

1. Host tree List of the monitored devices to which XNet Monitor applications
can be registered.

2. LocalIP column Trap status of the local IP address:

• If the IP address is registered to receive the trap messages,

the cell will appear as .

• If the IP address is not registered to receive the trap

messages, the cell will appear as .

3. IP Addresses columns List of all IP addresses of computers (max. 10 per host)
registered as trap targets to the corresponding host.

4. Add Local IP button Button that allows administrators to add the current XNet
Monitor IP Address on the monitored server.

5 Remove button Button that allows administrators to remove, in one go, a trap
target from all hosts it is registered to.

This button is used in combination with the drop-down list on
the left hand side, which allows the selection of the trap target
to be removed.

6 Trap Registration status
bar

The status field and progress bar at the bottom of the window
display the currently executed command and its progress
status.

2.3.2.Managing the Monitored Device Tree
From the File menu, commands make it possible to manage the device and server list available in the
Monitored Device Tree. This list is saved as an .xml file for future use and/or for transfer to another
monitoring computer. This allows easy sharing and management synchronization of servers and hosts
tree organization.

The following commands are available in the File menu.

Parameter Description

New To create a new virtual architecture from scratch.

Open To open an existing architecture saved as an xml file.

USER MANUAL

XNet Monitor  | 2. Configuration | 11



Parameter Description

Save To save the currently open architecture xml file.

Save As To save the currently open architecture xml file as a new file.

Exit To close and exit XNet Monitor

2.4. SNMP and General Settings

Introduction

In the Settings command in the Tools menu, you can set following parameters.

Click OK once the parameters are properly configured for your application.

Field Description

Parameter Description

# Local Clip
Threshold

When this number of clips is reached on a machine, a message will be displayed to
warn the user that a cleaning and purge will soon be necessary on that server.

Rem. Cap.
Threshold

Same warning as the previous one but based on the server remaining storage
capacity.
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Parameter Description

SNMP Polling
Period

Wait time between polling. A small period will guarantee fast refreshing of data but
will request high data flow on the network while a long period will display less up-
to-date data but will reduce the load on the network.

SNMP Time Out Delay after which a host will be considered as not responding. An alert message
will be displayed in the event log if such an event happens for a monitored host.

The automatic discovery process total duration depends on this parameter.

Enable Gigabit
ICMP Polling

Enables the pinging of the Servers GbE ports.

ICMP Time Out Time Out for the pinging of the Servers GbE ports

Enable Server
Reboot

If this option is enabled, XNet Monitor will be able to initiate a reboot of any
monitored server through the Reboot command in the contextual menu opened by
right-clicking on a host in the Monitored Device Tree.

Enable SNMP Log If this option is enabled, XNet Monitor will keep a log file with all SNMP messages.

Enable Server
Explorer

Enables the Explore option from the Server Name contextual menu in the
Monitored Devices Tree. The Explore option opens a ftp session on the server.

Enable LSM
Remote

Enables the LSM Remote option from the Server Name contextual menu in the
Monitored Device Tree.

Server Log Target
Directory

Path to the directory used to store the SNMP log files.

Temp. Unit Unit in which the temperature is expressed.
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3. Monitoring

3.1. Start Monitoring
Once servers and hosts have been added in the groups, the monitoring is started by clicking on the Start
command in the Monitoring menu.

To stop the monitoring once it is running, simply click on the Stop command in the same Monitoring
menu.

The monitoring status is available in the status bar at the bottom of the XNet Monitor window.

• ’Polling not started’ means that the monitoring has not been started yet since the application launch.

• ‘Polling’ followed by IP address means status data are presently read from the selected host MIB.

• ‘Waiting x/y sec’ indicates that the monitor is waiting for next polling process. It has already been
waiting for x seconds out of a total of y seconds (according to related parameter setting).

• ‘Polling ended’ means that the monitoring has been stopped by the user. At monitoring restart, hosts
will be immediately polled and the waiting period will be reset.

When you start up XNet Monitor, the monitoring is always stopped and must be
started manually using the Start command.
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3.2. Monitoring List

3.2.1. Description of the Monitoring List

Overview

The Monitoring List area shows the groups of EVS servers and other EVS hardware, their status, and a
set of parameters on each hardware.

The Monitoring List pane contains the areas highlighted on the screenshot below:

Area Description

The table below describes the various parts of Monitoring List area:

Part Name Description

1. Column heading Type of information available in the given column.

The columns available in the Monitoring List are selected and ordered as
defined in the section "Customizing the Monitoring List" on page 9.

2. Group node Name of the device or server group as defined in the Monitored Device
Tree.

3. Server List Information on EVS servers and other EVS hardware belonging to a group.
For more details on the fields available in this section, "Fields in the
Monitoring List" on page 16.

Clicking on a row corresponding to an EVS server or other hardware will
display the detailed information on this host in the Server Details area.
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3.2.2.Fields in the Monitoring List
The list of fields described in the table below is not exhaustive. It includes the fields available in the
default display:

Name Description

Name name of the EVS server.

The name displayed is assigned in the following order of priority, based on
whether a value is assigned or not: facility name, net name or IP address.

A color circle in front of the EVS server indicates its status:

• green: no active alert present for the server

• red: at least an active alert present for the given server

• gray: XNet Web cannot retrieve information with the SNMP protocol.

SN server's unique serial number.

Soft Rev. server software revision.

State functional status of the EVS server or other EVS hardware.

Genlock presence or absence of genlock synchronization signal, and its type.

Analog LTC status of LTC (Longitudinal Time Code) analogue signal.

Disk disk connection status, and the number of spare disks.

PSU status of the power supply units.

XNet Status status of the XNet network connection.

Traffic network traffic status.

DB Status status of the server database.

Loc. Clips number of clips stored on the server.

Rem. Capacity remaining recording capacity on the EVS server in hours, and percentage.
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3.3. Server Details

3.3.1. Overview on the Server Details Area
The Server Details area is located on the right hand side of the Monitored Device List.

When you select an EVS server in the Monitored Device List, the Server Details area provides detailed
information on the selected server.

This information is organized in five tabs, which are themselves organized in different group boxes:

Tab Name Included field groups

Status General information, data about A/V, network, controllers, GbE connections, and
channels

Storage Information on disk capacity, array definition, disk numbers, and disk models

Hardware List of the boards fitted on the EVS server

Codes List of Codes installed on the EVS server

MIB Browser View on the MIB (Management Information Base)

Temperature Temperatures measured at various points in the EVS server

Live IP Monitoring of PTP signal and SFP ports.

When you select another EVS hardware in the Monitored Device List, the Device Details area provides
data on the selected hardware, its drives and communication interfaces. See section "Device Details" on
page 33 for more information.
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3.3.2.Status Tab

Overview

In the Status tab, the main parameters are organized in several group boxes as shown on the following
figure.

The different group boxes and their parameters are detailed hereafter.

You will find more details on many of these parameters in the Configuration manual of the relevant EVS
server.

If Multicam is not active and running on the selected server, most of the parameter fields will
be left blank.
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General Area
The table below describes the fields available in the General area:

Parameter Description

Type Server type: XT3, XS3, …

Facility Name Name given to the product by the user.

Base Config. base configuration used to start the server.

In case of a Dual LSM configuration, the term Dual is added next to the active
base configuration.

Serial Number server's unique serial number.

Version server software revision.

State functional status of the EVS server or other EVS hardware.

PSU status of the power supply units.

Genlock presence or absence of genlock synchronization signal, and its type.

LTC status of LTC (Longitudinal Time Code) analogue signal.

Local Clips number of clips stored on the server.

Net Clips total number of clips stored on the whole XNet network.

Rem. Capacity remaining recording capacity on the EVS server in hours, and percentage.

Clip Capacity Clip capacity as defined on the server: Global or Per Channel.

Loop Recording Loop recording mode as defined on the server.

Up Time Elapsed time since the last boot.

Date Time MTPC date and time.

Sync PC to TC Indicates whether the internal TC is synchronized to the timecode read on the
LTC input of the server and whether the TC discontinuities detected on the LTC
input of the system are cleared.

Period Period at which the Sync PC to TC is applied.

PC Free Disk Space available space on the MTPC disk in megabytes (MB) or gigabytes (GB).

DB Status status of the server database.

Rec. Train Expiration Time lapse by which the field counter for the record trains has to be manually
reinitialized on the EVS server.

Failing a reinitialization, the record train will not longer be recorded. Warning
messages are issued in Multicam.
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Audio-Video Area
The table below describes the fields available in the Audio-Video area:

Parameter Description

AV Channels configuration defined for video and audio channels:

• number of IN and OUT video channels

• number of audio embedded mono channels per video channel

Video Std video standard used on the server ports.

Codec Config Codec essence(s) active on the EVS server.

On Air Codec Codec in which the video is played out on the EVS server.

Intra Codec Intra codec in which the video is stored on the EVS server.

Intra Bitrate Bitrate of compressed video data for the Intra codec.

LongGOP Codec LongGOP codec in which the video is stored on the EVS server.

LongGOP Bitrate Bitrate of compressed video data for the LongGOP codec.

Lo-Res Codec Lo-Res codec in which the video is stored on the EVS server.

Lo-Res Bitrate Bitrate of compressed video data for the Lo-Res codec.

Interface Connection interface an EVS server will use in 3D, 1080p, UHD-4K resolutions
or with the XIP or XT-VIA rear panel.

Presence of XHub-VIA is indicated by XIP - XHub.

HDR OETF function (opto-electric transfer function) used for High Dynamic Profile.
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Network Area
The table below describes the fields available in the Network area:

Parameter Description

XNet XNet network speed:

• 3G-SDTI

• XNet-VIA

• Off

Net # - Name Server identification number and name on the XNet network.

Net Type (Cfg) Defines the privileges of the EVS server on the XNet network.

The possible values are:

• Local

• XNet    

Also defines if the EVS server may or may not become the XNet

server.

The possible values are:

• Preferred

• Allowed

• Forbidden

Clip Edit by network Specifies whether a clip can be edited through the network or not.

XNet Status status of the XNet network connection.

Traffic network traffic status.

Network Copy/Push Preferred network (XNet or Gigabit) for copy, move and push actions on clips.

GigE Open Conn Number of open GbE connections on a given port.
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Controller / Protocol Area
The table below describes the fields available in the Controller / Protocol area:

Parameter Description

Port Port used by the server controller.

Controller\Protocol Controller or protocol used on that port.

Connection State Connection status of the control port.

If it is disconnected, Disconnected displays in red, and this generates an alert.

Network Connection Settings Area
The table below describes the fields available in the Network Connection Settings area for each PC LAN
(max. 2), each GbE port (max. 2), and each XNet-VIA interface (max. 1) being used on the EVS server:

If teaming is applied on the GbE ports, the GbE #2 port is referred to as "Not Present".

Only in Dual PC LAN mode, two PC LAN columns will be displayed.

Parameter Description

Status Status of the connection.

IP Address IP address of the interface port.

Subnet Mask IP mask of the interface port.

Def. Gateway Default gateway used by the interface port.

MAC Address MAC address of the hardware

Phys. Interface Physical location of the corresponding port

Mode Method used for IP address assignment (static or dynamic)

22 | May 2022 | 1.6.8.A



Channels Area
The table below describes the fields available in the Channels area:

Parameter Description

Channel Name of the record channel (CAM) or play (PGM) channel.

Status Status of the channel:

• CAM: Recording, Rec Idle

• PGM: Ready, Playing, Live, Idle

If a channel has no audio or video, it will be displayed in red with one of the
following indication:

• (!A) when the audio is missing

• (!V) when the video is missing

• (!AV) when the audio and video are missing

• (!IP) when the IP input stream is not properly configured and/or connected

Config Configuration of the channel as record or play channel.

SLSM recorders, as well as the number of phases, are specified in this field.

Rem. Capacity remaining capacity for each recorder channel.

LTC LTC timecode of the channel.

User TC User timecode of the channel.

1st Ctrl Primary controller defined for the selected channel.

Possible values are: EVS Remote, EVS XTNano Remote, AVSP, IPDP

2nd Ctrl Secondary controller defined for the channel, if any.

Parallel Ctrl Controller used in parallel mode.

OSD Controller (main or secondary) managing the OSD display characters in parallel
mode.
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3.3.3.Storage Tab

Overview

General Area
The table below describes the fields available in the General area:

Parameter Description

Rem. Capacity It specifies the remaining capacity of the storage expressed as a video duration
(hours, minutes and seconds) as well as a percentage.

Nominal Capacity It specifies the total capacity of the storage expressed as a video duration
(hours, minutes and seconds).

Storage Type It specifies the type of disks: SAS.

Raid Type It specifies the type of RAID:

• 4+1: four disks and a parity disk, with a spare disk

• 5+1: five disks and a parity disk, without a spare disk

• 10+1: ten disks and a parity disk, with 1 spare disk

• 10+2: ten disks and two parity disks, with 0 spare disks

24 | May 2022 | 1.6.8.A



Arrays Area
The table below describes the fields available in the Arrays area:

Parameter Description

PSU It specifies the status of the PSU on the given array.

See section "PSU HDX" on page 47 for examples of values for this field in case
of SAS-HDX array. The values are the same for other arrays types.

Fans It gives the state of the fans on the given array.

See section "Fan HDX" on page 47 for examples of values for this field in case of
SAS-HDX array. The values are the same for other arrays types.

Thermal It gives the temperature status on the given array.

See section "Disk Thermal" on page 48 for field values.

Raid Area
This area gives indication on the number of RAIDs defined in the server and their respective
identification (R1,…)

Parameter Description

Raid ID It specifies the RAID storage system identification

Disk Overview Tab

Disk Status Area

This area gives indication on the localization of each RAID and on the spare disks in the arrays:

The xx sign (red) identifies faulty disks, that should directly be replaced, especially when you work
without spare disks.

The sign (red) identifies disks other than EVS disks.

The sp sign (green) identifies the spare disks.
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Disk Temperature Area

This area provides the internal temperature of each disk.

Disk Details Button
The Disk Details button gives access to the Disk Information window:

Parameter Description

ID Disk identification

State Disk status: OK, not present, spare,…

Cap Disk capacity in Gigabytes

Temp Disk internal temperature in the unit defined in the general display settings

Sector Size Size of the disk sector

Model Disk manufacturer and model

Rev. Level Disk revision Level

SN Disk serial number
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3.3.4.Hardware Tab

Overview

The Hardware tab lists the available modules and boards installed in the server along with their
respective version or revision number and their configuration when relevant.

Board Area

Parameter Description

Name Name of the board or module

Version Revision of the board or module, and additional parameters

General Area

Parameter Description

Physical
Memory

RAM of the MTPC board

Hardware
Edition

version of the EVS server hardware, that corresponds to a specific set of board
revisions. The components of each hardware edition are detailed in the Tech Ref
manual, Hardware Edition History section.
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3.3.5.Codes Tab
The Codes tab lists the license codes activated on the server along with their description.
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3.3.6.MIB Browser Tab
The MIB Browser tab allows to view the MIB (Management Information Base) and provides a description
of the parameters that can be polled. This tab is dedicated to maintenance operations.
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3.3.7. Temperature Tab

Overview

The Temperature tab lists the temperatures measured in several points of the EVS server.

The measures are always given in Celsius degrees. The temperature settings do not impact these
measurements.

• Between 50 °C (122 °F) and 80 °C (176 °F), the warning range is reached and the temperature is
displayed on an orange background.

• Above 80 °C (176 °F), the alert range is reached and the temperature is displayed on a red
background.

These temperature measurements can also be displayed in the Monitoring List

Temperature Area

Parameter Description

Name Name of the board or module where the temperature is measured:

• Hxx Board: Controller board

• Hxx CPU: CPU module on the controller board

• Hxx Memory: Memory module on the controller board

• VCodec1: Codec1 module

• etc.

Value °C Temperature in Celsius degrees
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3.3.8.Live IP Tab

Overview

The Live IP tab allows you to monitor the SPF or QSFP interfaces and it also displays PTP related
information.

Without XHub-VIA Live IP Aggregator

With XHub-VIA Live IP Aggregator
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IP Interface Monitoring Area

The IP Interface Monitoring area allows to monitor the status, speed and input and output bandwidth
(expressed in Mbps) for each SFP or QSFP interface.

PTP Monitoring Area

The PTP Monitoring area shows Precision Time Protocol-related information.

The table below describes the fields available in the PTP Monitoring area:

Parameter Description

Status Status of the PTP.

• OK (green): locked to PTP clock, Organization Extension is activated on PTP
generator, the framerate is supported.

• Bad (red): not locked to PTP clock.

• OE issue (orange): locked to PTP clock, Organization Extension is not
activated on PTP generator or the framerate is not supported.

• System Framerate issue (yellow): locked to PTP clock, Organization
Extension is activated on PTP generator, the framerate configured on the
PTP is not in line with the XT framerate.

Locked Field indicating whether the server clock is aligned to the master clock or not.

Clock Mac Address MAC address of the grandmaster clock of the PTP infrastructure in the
IP network.

Frame Rate Supported framerate.

Master Module Indicates which of the SFP+ modules (PTP master module) operates as the
single PTP client for the XNet Monitor and synchronizes the other video codec
modules.

The PTP master module is the V4X module 1-C.
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Parameter Description

Profile Field specifying the PTP profile (set of required options, prohibited options,
ranges and defaults of configurable attributes) specific to the broadcast
industry and used by SMPTE 2110.

The supported profiles are:

• IEEE_1588_2008

• AES67_2015

• SMPTE_2059

• INTEROP_DEFAULT_AES_SMPTE

• INTEROP_AES_SMPTE

Domain Field specifying the PTP domain

• that contains the devices that need to share a common grandmaster clock

• in which the specified PTP profile has to be used.

This allows multiple timing systems to exist in the same network. Devices will
ignore and drop all messages on a domain different from their own.

Value between 0 and 127.

3.4. Device Details

Introduction

If a hardware other than an EVS server is selected in the Monitored Device List, the Device Details area
on the right displays detailed SNMP information.

This information is organized the following tabs, which are themselves organized in different group
boxes:

Tab Name Included field groups

Status Applications installed on the hardware, data on the computer, the drives, and the
communication interfaces

MIB Browser View on the MIB (Management Information Base)
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Status Tab

In the Status tab, the main parameters are organized in several group boxes as shown on the following
figure.

The different group boxes and their parameters are detailed hereafter.

EVS Products

Parameter Description

Type EVS application name.

Version Server software revision.

State Server state: running, in maintenance, faulty, halted, unknown.

Custom Name Name given to the product from the MIB.

34 | May 2022 | 1.6.8.A



Computer

Parameter Description

Name Name of the computer.

CPU Usage Percentage of use of central processing unit (CPU).

Physical Memory Computer data storage used from the total amount.

Up Time Elapsed time since the last boot.

Date Time MTPC date and time.

Drives
This area lists the hard disks drives from the computer.

Parameter Description

Name Name of the computer.

Total Size Total size (GB) of the drive.

Free Space Free space (GB) still available on the drive.

Interfaces

Parameter Description

Description Generic description of the communication interface.

Status Up or Down

MTU Maximum Transmission Unit: size (in bytes) of the largest protocol data unit that the
layer can pass onwards.

Speed Data transfer rate in Megabits per second.

Phys.
Address

Memory address that is electronically (in the form of binary number) presented on the
computer address bus circuitry in order to enable the data bus to access a particular
storage cell of main memory.

IP Address Internet Protocol address of the communication interface.

Net Mask Prefix bit mask expressed in quad-dotted decimal representation. For example,
255.255.255.0 is the subnet mask for the 192.168.1.0/24 prefix.

NIC IN Number of octets getting through the network (input)

NIC OUT Number of octets getting through the network (output)
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MIB Browser Tab

See section "MIB Browser Tab" on page 29 for an overview of the MIB Browser tab.

3.5. Extracting SNMP Information
To extract SNMP information relative to an EVS server, proceed as follows:

1. Right-click on the server in the Monitored Device Tree.

2. Select Extract SNMP Information from the contextual menu.

The extraction starts and once it is done, the SNMP Information Extraction window displays the .html file
name and its storing folder and path:

3.6. Alert Messages

3.6.1. Description of Alerts Pane

Introduction

The Alerts pane is displayed below the Monitoring List pane on the Monitoring window.

It shows the list of SNMP alerts generated for the monitored devices (host or host groups) selected in
the Monitored Device tree.

The alert messages are displayed until you acknowledge them.

In the Alerts pane, you can:

• display alerts based on alert categories.

• sort the columns in the alert list.

• acknowledge an (active) alert.
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Use the Filter drop-down menu to select the alerts to be displayed:

Category Description

All All alerts that occurred during the selected period are displayed.

Acknowledged Only alerts that have already been acknowledged are displayed.

Not
Acknowledged

Only alerts that do not have been acknowledged yet are displayed.

Area Description
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The table below describes the various parts of Alerts pane:

Part Name Description

1. Alert filter Drop-down field that allows you to select the alert category to be
displayed in the grid, as well as the date range when the alert was
generated.

On the right, the Ack Alert(s) icon allows you to acknowledge all displayed
alerts.

2. Column heading Type of information available in the given column.

Clicking on the column heading allows the sorting of the elements in
ascending or descending order.

The columns displayed cannot be modified:

• Name: Name of the host

• IP Address: IP address of the host

• Date: Date and time when the alert was generated

• Alert Message: Error message (For full information on error messages,
"List of Possible Alerts" on page 39).

3. Alert Information Information on the alerts displayed.

3.6.2.Managing Alerts

Introduction

This topic explains how you can display and manage alerts from the Alerts area in the Monitoring
window. The possible actions are summarized in a table below.
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Possible Actions on Alerts

In order to ... Proceed as follows:

Filter the alerts to be displayed Select the requested alert category in the Filter drop-down field,
and the date range in which the alerts to be displayed have been
generated.

Sort the alert items based on the
values of a column
(ascending or descending order)

Click the column heading on which the alert items should be
sorted.

Acknowledge alerts Click the Ack Alert(s) on the right of the filter fields.

All alerts displayed are removed from the Alert list, and added to
the Acknowledged list.

3.6.3.List of Possible Alerts

Introduction

The section describes the fields for which an alert can be generated and the associated default
message(s) (normal status) and alert/error messages.

The warnings are displayed in orange, and the errors in red.

Working Principle

When an error is generated for a field, it is displayed in the Monitoring window:

• as an alert in the Alerts pane if the given field is not selected in the Alert Configuration window.

The alert must be acknowledged by an administrator user to be removed from the list of active
alerts. It is then sent to the list of acknowledge alerts.

• as an error message in the Server Details pane, and possibly in the Monitoring List pane (if the
related field is displayed).

When the SNMP information is sent back and when the situation is back to normal or when the alert
is acknowledged, the field status is updated accordingly, and the error is replaced by the normal
status.
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Polling Status

It specifies the status of the polling service. It indicates: whether the polling service is running
correctlywhen the polling service last sent a query to the server (time interval in hh:mm:ss from current
time)

Possible Values

Message Explanation Status
Type

OK (00:03:00) The polling service is working correctly, and the SNMP data was last sent
3 minutes ago.

Info

No response to
IMCP polling

An ICMP (Internet Control Message Protocol) timeout was generated: the
information was not sent in the requested time interval.

Error

No response to
SNMP polling

An SNMP timeout was generated: the information was not sent in the
requested time interval.

Error

State

It specifies the functional status of the EVS server or other EVS hardware.

Possible Values

Message Explanation Status
Type

Running The EVS server is running a given configuration. Info

Not Running The EVS server is not running a configuration Info

Initializing The EVS server is initializing (in the boot sequence). Error

Maintenance The EVS server is in the Multicam Setup window, hence it is not running a
given configuration yet.

Error

Halted The EVS server is turned off. Error
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GbE 1/2 and PC LAN 1/2 Status

It specifies the operational status of the Gigabit Ethernet interface connectors (port 1 & 2), the PC LAN
connectors (port 1 & 2), as well as issues related to GbE and/or PC LAN teaming.

Possible Values

Message Explanation Status
Type

GUI

Up The corresponding GbE or PC LAN interface is installed and
running well.

Info Server
Details

Down The corresponding GbE or PC LAN interface is not working. Error Server
Details

Not present The corresponding GbE or PC LAN is NOT installed. Error Server
Details

GbE Port 1:
operational
status is Down

The GbE port 1 is not working. Error Alerts

PC LAN Port 1:
operational
status is Down

The PC LAN port 1 is not working. Error Alerts

Team Up The GbE or PC LAN interfaces are running well, and the both
links work correctly in teaming.

Info Server
Details

Team Link 1
Down

The GbE link 2 or PC LAN link 2 is functional whereas the GbE
link 1 or PC LAN link 1 is either not cabled, or does not work
properly.

Error Server
Details

Team Link 2
Down

The GbE link 1 or PC LAN link 1 is functional whereas the GbE
link 2 or PC LAN link 2 is either not cabled, or does not work
properly.

Error Server
Details

Team Down The GbE or PC LAN interfaces are installed but do not work
properly on both links.

Error Server
Details
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Message Explanation Status
Type

GUI

GbE Port 1/
PC LAN Port 1:
operational
status is
degraded -
team link 1
down

The GbE link 2 or PC LAN link 2 is functional whereas the GbE
link 1 or PC LAN link 1 is either not cabled, or does not work
properly.

Error Alerts

GbE Port 1/
PC LAN Port 1:
operational
status is
degraded -
team link 2
down

The GbE link 1 or PC LAN link 1 is functional whereas the GbE
link 2 or PC LAN link 2 is either not cabled, or does not work
properly.

Error Alerts

Controller

It specifies the connection status of a given controller enabled on an EVS server.

Depending on the pane where the message is displayed, it is displayed in slightly different ways.

Possible Values

Message Explanation Status
Type

GUI

OK All defined controllers are connected, which means up and
running.

Info Mon.
List

Connected The corresponding controller is up and running. Info Server
Details

Defined The corresponding controller is defined in the configuration
but is not used

Info Server
Details

Disconnected The corresponding defined controller is disconnected, or the
external communication has been lost.

Error Server
Details

XX on RS422 #Y
disconnected

The given controller(s) (XX) is/are disconnected on the given
RS422 port number (Y) of the EVS server.

Error Alerts

Pane
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Channels

It specifies errors on the status of the record or play channels.

Possible Values

Message Explanation Status
Type

GUI

Recording Normal status on the recorded media. Info Server
Details

Recording (!A) Embedded audio missing on the recorded
media.

Error Server
Details

CAM X: audio embedded
missing

Error Alerts

Recording (!V) Video missing on the recorded media. Error Server
Details

CAM X: video missing Error Alerts

Genlock

It specifies the presence or absence of genlock synchronization signal, and its type.

Possible Values

Message Explanation Status Type

OK Blackburst A valid Blackburst signal is present. Info

OK Tri-level A valid Tri-level signal is present. Info

Bad Blackburst Bad Blackburst signal Error

Unknown Blackburst No Blackburst signal detected Error

Bad Tri-level Bad Tri-level signal Error

Unknown Tri-level No Tri-level signal detected Error
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Analog LTC

It specifies the status of LTC (Longitudinal Time Code) analogue signal.

Possible Values

Message Explanation Status Type

OK A valid LTC signal is present on the EVS server. Info

Missing No LTC signal is detected on the EVS server. Error

Corrupted A bad LTC or an LTC drift is detected on the EVS server. Error

Local Clips

It specifies the number of clips stored on the server.

For local clips, the alert generation depends on the threshold defined for the Local Clips field in the
Monitoring settings defined in the Tools > Settings menu. The default threshold is 4000.

Possible Values

Message Explanation Status
Type

3500 When the number of clips is displayed in black, it means the number of clips on
the EVS server does not exceed the threshold defined for the maximum number
of local clips.

Info

4200 When the number of clips is displayed in red and bold characters, it means the
number of clips on the EVS server exceeds the threshold defined for the
maximum number of local clips.

Error

DB Status

It specifies the status of the server database.

Possible Values

Message Explanation Status Type

OK The DB is OK. Info

Corrupted The DB is corrupted. Error

44 | May 2022 | 1.6.8.A



XNet Status

It specifies the status of the XNet network connection.

Possible Values

Message Explanation Status
Type

Connected The EVS server is connected to the network. Info

Connecting The EVS server's connection to the network is in progress. Info

Stand alone The system does not have the XNet license, or the required
hardware, or the XNet network is disabled.

Info

Not Connected The EVS server is not connected to the network. Error

Disconnected The EVS server is in a disconnection phase. Error

Connection fault The EVS server cannot connect to the XNet network due to an
incompatibility error.

Error

Traffic

It specifies the network traffic status.

Possible Values

Message Explanation Status
Type

Normal The traffic on the XNet network is properly managed. Info

Heavy The XNet network makes full use of the available capacity. Warning
(orange)

Corrupted The XNet network is overloaded, has lost at least one command from a
controller, and is desynchronized.

Error
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Rem. Capacity

It specifies the remaining recording capacity on the EVS server in hours, and percentage.

The alert generation depends on the threshold defined for the Remaining Capacity field in the
Monitoring settings defined in the Tools > Settings menu. The default threshold is 5%.

Possible Values

Message Explanation Status
Type

48:01:53 (97%) The parameter is in a valid state (black font) when the Remaining
Capacity threshold is not exceeded.

Info

01:03:32 (2%) The parameter is in a warning state (orange font) when the
Remaining Capacity threshold is exceeded.

Warning

00:00:00 (0%) The parameter is in an error state (red font) when the Remaining
Capacity is null.

Error

PSU

It specifies the status of the power supply units..

Possible Values

Message Explanation Status Type

OK (1) Only one PSU is installed on the server and is working fine Info

OK (2) Two PSUs are installed and are working fine Info

! PSU 1 The first PSU is down. Error

! PSU 2 The second PSU is down. Error
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PSU HDX

It specifies the status of the power supply units of the external SAS disk array.

Possible Values

Message Explanation Status Type

OK (1) Only one PSU is installed on the SAS-HDX disk array and is working fine Info

OK (2) Two PSUs are installed on the SAS-HDX disk array and working fine. Info

/ No external storage system is installed. Info

! PSU1 The first PSU of the SAS-HDX disk array is down. Error

! PSU2 The second PSU of the SAS-HDX disk array is down. Error

Fan HDX

It specifies the state of the fans on the external SAS disk array.

Possible Values

Message Explanation Status Type

OK The fans is/are operating. Info

/ No external disk array is installed. Info

! Fan 1

! Fan 1,2

The fan 1 is faulty.

The fans 1 and 2 are faulty.

Error
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Disk Thermal

It specifies the temperature on the internal and external disks.

Possible Values

Message Explanation Status
Type

OK All temperatures measured on disks are OK. Info

INT 1: Rising The temperature of disk 1 on the internal disk array is rising
(between 50 and 55°C).

Warning

EXT 2-3 : Rising The temperature of disk 3 of the second external disk array 2 is
rising (between 50 and 55°C).

Warning

INT 1-2 : Overheating The temperature of disk 2 of the first internal disk storage board 1
exceeds 55°C.

Error

RAID

It specifies the status of the raids.

Possible Values

Message Explanation Status
Type

OK The raid system is working fine. Info

R1: Rebuilt
X%

The system is rebuilding raid 1 of the raid matrix, X standing for the part of the
rebuild operation processed in %.

In the Server Details pane, Storage tab, the raid has an orange background in
the RAID area.

Warning

R1:
Degraded

The raid 1 of the raid matrix has lost a disk and cannot afford any new disk
failure without loosing the full storage.

In the Server Details pane, Storage tab, the raid has a red background in the
RAID area.

Error
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Raid R/W Retry

It specifies the number of renewed attempts of read and/or write operations on disks of the raids.

As soon as at least one read or write operation has been retried, this generates a warning.

Possible Values

Message Explanation Status Type

0r / 0w 0 renewed read attempt, 0 renewed write attempt Info

0r / 1w 0 renewed read attempt, 1 renewed write attempt Warning

Raid R/W Error

It specifies the number of errors in read and/or write operations on disks of the raids.

As soon as at least one read or write operation has failed, this generates an error.

Possible Values

Message Explanation Status Type

0r / 0w 0 read error, 0 write error Info

0r / 1w 0 read error, 1 write error Error
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Disk

It specifies the disk connection status, and the number of spare disks.

Possible Values

Message Explanation Status
Type

GUI

OK (1 sp) All disks are connected and accepted by the RAID matrix, and
1 spare disk is available.

Info Mon. List

1 xx (6 sp) All disks are connected and accepted by the RAID matrix, but
one disk is faulty, and 6 spare disks are available.

Error Mon. List

OK The given disk is working fine. Info Server
Details

Spare The given disk is a spare disk. Info Server
Details

INT/EXT X-X
Disconnected

The given disk on the internal or external array (array number
+ disk number) is out of the RAID matrix.

Error Alerts &
Server
Details

INT/EXT X-X

Not Present

No disk is connected on the internal or external array (array
number + disk number).

Error Alerts &
Server
Details

PC Free Disk Space

It specifies the available space on the MTPC disk in megabytes (MB) or gigabytes (GB).

Possible Values

Message Explanation Status
Type

300 MB When the space available is more than the value defined in the SNMP agent
(100 MB), the label is in a normal state.

Info

75 MB When the space available is less than the value defined in the SNMP agent
(100 MB), the label is in a warning state. For PCs (no MTPC card), this value is
not displayed as a warning.

Warning

10 MB When the space available is less than 20MB, the label is in an error state. For
PCs (no MTPC card), this value is not displayed as a warning.

Error
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Rec Train Expiration

It specifies that the remaining time left before you have to reinitialize the field counter for the record
trains.

Possible Values

Message Explanation Status
Type

GUI

Record Train Maintenance should be
performed in less than 12 weeks.

It remains between 4 and 12 weeks to
reinitialize the record train field counter.

Warning Alert

Record Train Maintenance should be
performed in less than 28 days.

It remains less than 4 weeks to reinitialize
the record train field counter.

Error Alerts

Temperature

It specifies the temperature of the hardware components.

Possible Values

Message Explanation Status Type GUI

The system has encountered a
temperature issue. Please
consider restarting Multicam at
your earliest convenience

The temperature exceeds the warning
threshold (80 degrees).

Error Alerts

The system has encountered a
serious temperature issue.
Please shut down the server as
soon as possible

The temperature exceeds the maximum
threshold (95 degrees).

Error Alerts
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Other

Possible Values

Message Explanation Status Type GUI

Your server ran into a problem
that it couldn’t handle. To keep
the server operating optimally, a
reboot is recommended.

A division by 0 occurred in the Linux
kernel when Multicam was running.

Error Alerts

The system has encountered a
System Backup issue. A backup
of your content is recommended
before restarting Multicam.

A system backup issue occurred. Error Alerts

The system has encountered a
RAID access issue. Please
restart Multicam as soon as
possible. Stopping the recorders
is recommended

There was an issue with the R4X board. Error Alerts

3.7. Disk Usage
The Disk Usage pane displays a summary of the total used and remaining disk space. This total is
computed for all disks available on the server or group of servers selected in the Monitored Device Tree.

A color pie chart helps you to immediately visualize the disk usage of your system. More precise figures
are given over that pie chart, expressed as a used and remaining video time in hours, minutes and
seconds.
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4. Server Maintenance Tasks

4.1. Multicam Upgrades

4.1.1. Installing a Multicam Version

How to Install a Multicam Version on an EVS Video Server

With Multicam versions 15.XX and higher, the Multicam installation file (.gz file) is
directly made available and can be used as such in XNet Monitor to update your
Multicam version.

To remotely update Multicam on one or several servers, proceed as follows:

1. In the Tools menu, select Server > Install Versions. The Installation window appears:

2. Select the server(s) to update in the left pane of the Installation window.

As a reminder, the currently installed Multicam version is displayed next to each server.

3. In the Version field, browse your computer to select the newMulticam installation zip file.

4. Click on the Install button to start the installation process on all selected servers.
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5. Before the server upgrade starts, the installer checks the number of Multicam versions installed on
each server.

If more than 10 versions are installed on the EVS server, an error message appears requesting you to
remove old versions before installing a new one. Otherwise, the upgrade process is automatically
launched.

If you get the above message, do the following:

a. Click OK. The Remove Installed Versions window appears.

b. Remove the requested versions as described in the section "Installing a Multicam Version" on
page 53 ‘"Installing a Multicam Version" on page 53', on page "Installing a Multicam Version" on
page 53.

The upgrade process is then launched. When the servers are upgraded, they are restarted, but you still
need to launch the requested application.
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4.1.2. Removing a Multicam Version
Servers currently running Multicam 14 will not showMulticam 15 versions and higher.

How to Remove a Multicam Version from an EVS Server

To remove previously installed Multicam versions from an EVS server, proceed as follows:

1. In the Tools menu, select Server > Remove Installed Versions.

The Remove Installed Versions window appears.

2. Click the version(s) you want to remove.

The selected versions are highlighted in black.

3. Click the Remove Selected Versions button.

4. Click Close.
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4.2. Remote Access to an EVS Server

4.2.1. Accessing Remotely a Server Desktop
To access remotely a server desktop, proceed as follows:

1. Right-click on a server name, and select Remote Desktop from the contextual menu.

A message appears to warn you that you are going to take control of the EVS server:

2. Click OK to open the server window:

From this window, you are able to navigate through Multicam Configuration module exactly as you
would access it using a keyboard.
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4.2.2.Accessing the MulticamWeb Setup
To access remotely a server desktop, proceed as follows:

1. Right-click on a server name, and select Web configuration from the contextual menu.

A message appears to warn you that you are going to take control of the EVS server:

2. Click OK to open the server screen.

The MulticamWeb Setup window opens.

Refer to the EVS Server Configuration manuals for more information.

4.2.3.Accessing Remotely an LSM Remote
Panel

This function must only be used for training purposes. It is not intended to be used for
operations.

1. To connect to and take control of an LSM Remote connected to a server, proceed as follows:

2. Right-click on a server name and select LSM Remote from the contextual menu.

3. In the following window, select the port number linked to the physical remote device:
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4. Clicking OK opens an interactive window representing the LSM remote panel and from which you
can use the different commands, such as on the physical remote itself.

You can close this window by pressing Escape.

4.2.4.Rebooting an EVS Server
To remotely reboot a server, right-click on it in the Monitored Device Tree and select Reboot in the
contextual menu.

The Server Reboot message window is displayed. You must confirm the reboot process to start it on the
remote host.

This command will be available only if the corresponding parameter is enabled in the
Settings window.
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4.3. Uploading a Keyword File on an EVS
Server

To upload a keyword file on one or several servers, proceed as follows:

1. In the Tools menu, select Server > Keyword Files. The Keywords window appears.

2. Select the server(s) to receive the keyword file in the left pane of the Keywords window.

3. In the Keyword File field, browse your computer to select the keyword file to upload.

4. Click on the Upload button to start the keyword file copy on all selected servers.

4.4. Server Logs Extraction
To remotely recover the SNMP logs stored on a server, right-click on it in the Monitored Device Tree and
select Extract logs in the contextual menu.

The following warning message window is displayed to warn you that the extraction process may
interfere with the video diffusion from that server. Launch the extraction process again later if you
cannot accept any diffusion trouble at this time.
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The next window displays progress bars of the extraction and the current directory and file being
downloaded.

Once the logs extraction is done, a window briefly appears about the log files compression then the
Logs Extraction window displays the zip file name and its storing folder and path.

The different logged information (configuration, alerts…) is stored in different folders and files and
packed together in a zip file. Next to the zip files is a text file (LogExtracion_servername.log) for each
server that logs the extractions dates, operations, results and resulting zip file.

At log extraction, the log file on the remote server is closed and transferred. After this
operation, a new log file is created on the remote server to log the events that happen
from now on.
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